Системи с Програмируема Логика                                       Лабораторно Упражнение No5, 2011


FPGA implementation of a simple dual-core processor system
The goal of this Lab exercise is VHDL- design and implementation of a compact dual core system based on the free KCPSM3 soft-microcontroller.   
I. Task introduction

The current lab assignment serves as a brief introduction to the world of VHDL soft-processor embedded systems. The term soft-processor usually refers to a kind of a microprocessor which is entirely composed of FPGA logic primitives, thus possessing the ability of easy customization as well as robust reconfiguration and fast time to market setup. Most of the latest popular HDL microcontrollers are available in the form of paid IP (Intellectual property) modules or distributed free of charge but often with limited features.   

In terms of our practical educational interest, we are going to get acquainted with the KCPSM3 IP core. It is a small 8-bit microcontroller aimed primarly at Spartan-3 enabled devices but also suitable for use in Virtex-II and Virtex-IIPro kits. Although it could be used for data processing purposes, it is most likely to be employed in non-time critical state machine applications. No matter what the underlying engineering assignment is, KCPSM3 has been developed with one dominant factor in mind – small size! The complete synthesized controller occupies just 96 Spartan-3 slice blocks which is approximately 5% resource utilization - in the case of the XC3S200 chip and less than 0.3% of the XC3S5000 FPGA chip. Besides the small logical footprint, a single block RAM is occupied to function as a ROM program storage. 

Of course, as you may expect, the small size of the whole controller doesn’t come without any drawbacks – your assembler code cannot contain more than 1024 instructions and you should confrom to the 8-bit data interface of the core. Those facts may seem repelling for many serious practical tasks, but you will certainly appreciate KCPSM3’s flexibility and lack of any external hardware support when you need some embedded processing at absolutely no cost. You can easily connect any custom VHDL logic to interact with your soft-core design and tune the performance according to your project requirements without the need of buying external programming modules or bearing any hardware risks. As it is stated in the processor’s documentation – it is not so much what is inside the KCPSM3’s module that makes it useful, but the environment in which it operates ;) 
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 fig. 1 a simplified block diagram of the KCPSM3 module
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fig. 2 an exmple dual-core chip architecture
Let us now proceed with examining the architecture of a sample dual-core embedded system built up of two interconnected KCPSM3 soft cores. An example schematic is given on fig.2. Together with the inclusion of the two cores, the project contains the following components:
- two blocks of RAM – a fast single (16x8) four-port distributed RAM module comprised entirely of logical slices and another bigger one – a 16kx8 four-port memory, used for normal intercore communication and built up from some of the available FPGA RAM blocks;

- two ROM modules – they are required for KCPSM3 configuration and program storage;

- a controller for common data bus access resolution;

- an interrupt management controller enabling each of the soft-cores to handle incoming external interrupt signals.

Basically, the proposed multi-core design possesses the capability to maintain two separate 8-bit hexadecimal counter registers, incremented via an onboard rotary switch (the content of the first register is increased by one with each turn to the left and similarly – the second register is incremented with each right turn). The fisrt KCPSM3 core has the task to command a simple moving LED light pattern when in idle state. Each rotary siwtch movement causes an interrupt in the processor’s background task which makes the core determine the direction of the rotation and update the corresponding counter registers by reading a separate direction signal coming from an accompanying guarding rotation module, connected to the switch. The new values of the counter registers are stored in the larger RAM block, after which the first soft-core causes an interrupt in the second soft-processor. The second KCPSM3 controller on its own now proceeds with reading the changed values from a specified location in the common four-port memory, after which continues with its main task of displaying the counters’ contents on the board’s dot-matrix display. 
 For the sake of a better design understanding – a simplified block diagram of the complete system’s structural architecture is provided in the usual manner in fig.3 below.
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fig. 3 complete structural diagram of the proposed dual-core design

In order to understand the technical nature of the KCPSM3 microcontroller let us concentrate on its internal schematics for a while – look at fig. 4 for a quick overview.
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fig. 4 KCPSM3 soft-processor overview

Some of the most important internal components are the following:

- 16 common purpose registers (labelled from s0 to sF). In some special cases it is possible for the designer to rename them as needed for a better legibility. All of the listed registers are of equal priority and when they are provided as valid instruction operands – the final result is directly stored in the referenced location without any additional intermediate accumulator registers;

- arithmetic logic unit (ALU) – serves to provide the typical basic set of arithmetic operations – allowed operands are any of the above-mentioned general purpose registers as well as any 8-bit constants. The ALU module supports adding (ADD), subtraction (SUB), bitwise operations (AND, OR and XOR), comparison and bitwise test operations (COMPARE and TEST) and last but not least – bitwise shift operations (SHIFT and ROTATE). Fig. 5 portrays the available instruction set:

- flags – all ALU operations influence the state of the three available one-bit flags depending on the produced arithmetic outcome. The ZERO flag, as the name suggests, indicates whether the last operation’s results is zero, while the CARRY flag may have several different signal states – again depending on the last executed arithmetic instruction. The INTERRUPT_ENABLE flag is responsible for enabling or disabling interrupt detection and handling.

- 64-Byte Scratchpad memory – used as a fast temporary memory location with general purpose. It is accessed via the instructions STORE and FETCH which require one of the 16 predefined available registers (from s0 to sF as data operands). In this way, the designer may declare and use a relatively large number of local variables for temporary data interaction. The addresses are 6-bit wide and may be provided directly as constants or via the content of some of the general purpose registers. Bear in mind that the given address must always be in the range from 00 to 3F;

- I/O – the KCPSM3 soft-core has also a few input/output ports which enhance the microcontroller’s inteconnection abilities. You may easily connect the available I/O ports to any external user-defined VHDL components but you should be aware of the existing limitation for 256 inputs and 256 outputs at maximum. The PORT-ID pin is an output port address output. Upon an INPUT operation – the processor reads data from the IN_PORT input port and stores the data content in the second operand sx (one of the general purpose registers). In a similar fashion, upon an OUTPUT operation – the processor fetches the content of the first operand sx into the port OUT_PORT.

- program counter (PC) – it stores the address of the next instruction to be executed. By default, the content of the program counter is automatically incremented by one upon each one successful instructiuon completion. However, there are special conditional and transition instructions which change the PC’s normal behaviour – they are JUMP, CALL, RETURN and RETURNI, as well as the guarding signals Interrupt and Reset! The program counter cannot be explicitly modified and since it is 10-bit wide the valid addresses fall into the range from 000 to 3FF (it goes without saying that upon reaching 3FF – the counter starts again from the initial address - 000).

- CALL/RETURN stack – the built-in hardware stack is capable of storing up to 31 instruction addresses – thus enabling the user to memorize up to 31 interrupt levels if necessary. The program stack is organized as a cyclic buffer – when it becomes full with data – new instruction addresses are written from the beginning replacing the existing ones. In addition, be aware of the fact that no special instructions exist for stack manipulation – so if your program becomes too complex or if you plan to handle many „deep” interruption levels – you had better choose another soft-controller.

- INTERRUPT port – it is responsible for asynchronous external interrupt signal detection. An interrupt may occur at any moment in time, but it is recommended that all processor inputs should be synchronized by the board’s clock pattern. The KCPSM3 core (aka. PicoBlaze) ensures that the interrupt will be handled for up to 5 clock cycles!

- Reset signal – used for reinitializaton during which the program counter is reset at 0, all flags are also initialized with zeros, interrupt handling is forbidden and the CALL/RETURN stack is cleared. Note that the Scratchpad memory and the 16 general purpose registers are left intact and are not reset! 
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fig. 5 KCPSM3 instruction set

Apart from the processor’s structure, the second key component in the proposed example design is the organization of the intercore four-port memory block. The design process goes through several phases:

- The final four-port concept is based on a typical dual-port block RAM which is readily available on the FPGA chip.
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fig. 6 a single dual-port RAM block

- The suggested idea is further developed by the creation of a tri-port memory by combining the write address inputs as well as the data inputs. In this way, each writing operation leads to data duplication in each one of the included two dual-port memory blocks. An example schematic is given in fig.7.
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fig. 7 a simple tri-port RAM 

In order for both processor cores to be able to access the common memory block we decide to convert the tri-port memory into a four-port one with the help of another built-in on-chip component – the DCM (digital clock manager) block. The latter has the capability of increasing or multiplying the frequency of the original clock pattern at a specified scale factor. In our case, the DCM block acts as a frequency doubler giving the soft-controllers as a result enough time to operate with the memory for a single unmodified clock cycle. We should only add three additional multiplexers helping us to ensure correct address and input signal handling during the writing phase.
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fig. 8 final four-port RAM architecture


More information about the DCM module and its feature set may be found in the related Spartan-3 documentation. So, having already outlined our common memory structure, we are ready to describe the complete dual-core memory inteface schematically. Fig 9 illustrates the signal interconnections in a better way in comparison with the structural diagram in fig. 2. Note how port_id and out_port output ports are used in this case.
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fig. 9 KCPSM3 memory interfacing


The complete wiring for the first core is provided in fig.10 below. By analogy, you may easily determine the second core’s signal pathways.
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fig. 10 KCPSM3 memory interfacing continued

In conclusion, the proposed dual-core system is designed in a clever and compact way – especially with the combination of the already introduced four-port memory. Except for the small 16x8 distributed RAM, the project’s components not only utilize a small fraction of the FPGA chip’s resources but are declared in such a way that Project Navigator’s synthesis module automatically recognizes and optimizes all HDL components for speed and performance. Despite the fact that as a whole the system may seem a bit complicated in the beginning – it poses the right balance between sheer size and architectural simplicity as a starting point in studying soft-processor embedded design.

Since we are limited in space and time – the current lab assignment will not focus your attention on a thorough step-by-step assembly procedure of the system. Instead – you will be provided with the complete working sample project having the task to examine its structure and make several small changes in one of the core’s programs. 
II. Realization steps
Copy the design WebPACK project foulder, named Double_Core_Valya9, from the directory C:\VLSI_LAB_EX into your student lab group directory (for example C:\VLSI\gr231a).

1. Open the your copy of design WebPACK project (named Double_Core_Valya9), located in the your lab group directory:
1.1. Start Project Navigator (Xilinx ISE 9.2 - the program responsible for facilitation of our VHDL design flow)
- icon Xilinx ISE (Integrated Software Environment) on Desktop
[image: image12.png]



- or by  Windows commands :  Start => Programs => Xilinx ISE 9.2i =>  Project Navigator
1.2. Open  a new project through Project Navigator’s main menu strip:

File => Open Project
1.3. In the just opened “Open File Wizard” window open the project Double_Core_Valya9 in your student lab group directory (for example C:\VLSI\gr231a).:
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fig. 11 main window of the Open Project Wizard
- in the “Project Location” field specify the your student lab group foulder (for example C:\VLSI\gr231a);
- choose your the desired project’s  name  – Double_Core_Valya9 in the File Name filed – this will automatically open all important project files (modules);
1.4. Pay attention to the hierarchical structure of the Sources window. DoubleCoreValya9 is the name of the top-level source file which serves as a container of all subordinate components. Do not be deluded by the name of the architecture – although it is declared as Behavioural – this does not prevent you from creating a valid top-level structural description. However, when you design your own projects – it is always considered a better practice to make use of the keyword Structural. 
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fig. 12 Sources pane of the dual-core system

The listed VHDL sources are as follows:

-DoubleCoreValya9 – this is the main top-level source container;

-core1 – an instantiation of the first KCPSM3 soft-core;

-program_rom1 – the ROM memory for the control program of the first core;

-core2 – an instantiation of the second KCPSM3 soft-core;

-program_rom2 – again – the corresponding second ROM memory;

-FportSpeedC – the smaller 16x8 four-port distributed memory;

-FportB – a structural description of the larger common four-port RAM block;

-Bcontrl – the VHDL bus controller entity;

-Hex2Seven – an assisting component for seven-segment indication of the two counters’ least significant digits;

-ucf – as the name implies – this is the final portmap file configured this time for another more feature-rich FPGA board.
- Start the design processes (Implement Design in Processes) and then generate the programming file (Generate Programming File in Processes) for this project version. If everything is correct – we will test the the project implementation in practice. This time, programming is accomplished via Project Navigator’s iMPACT program  – look at next figure for orientation:
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Starting the iMPACT programming module
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 Press Finish and proceed with the target chip selection
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- Now, you should be quite careful with the choice of target chip because the XC3S500 starter kit possesses one FPGA chip, one ROM chip and an additional Intel flash memory block. From the pop-up dialog – select DoubleCoreValya9.bit programming file and after an initial Open selection – choose Bypass for the next two windows!
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Press Open and then Bypass the next two windows

- Right-click the first chip on the left and choose Program from the context menu! In this way, the FPGA chip is reconfigured as planned. We may now observe the behaviour of our „hello-world” KCPSM3 program.
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Final programming of the FPGA chip

- Upon successful completion of all operations you should  check the executing of the double core processor programs:
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We will simulate the large four-port memory of the double core processor.
1.5. Set the large four-port memory as the current top-level module now (look at fig. 13 for directions). This is needed so as to be able to test the behaviour of the four-port RAM block. Afterwards, create a new Test Bench Waveform source file for the exact simulation.
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fig. 13 changing the current top-level VHDL source 

- Make sure you choose Generate Programming File before proceeding with the simulation!
- Execute the following main menu commands:

Project => New Source…
-In the just opened “New Source Wizard – Select Source Type” window choose the module type:  Test Bench WaveForm and in the “File name” field enter the name of the file containing this module: Testing (see fig.14). Then, press the “Next” button. Associate the simulation file to the newly specified main module – FportB.vhd – see fig.15!
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fig. 14 addition of the new simulation source file
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fig. 15 choosing the four-port RAM module as the one going to be tested
-Continue with the configuration of the simulation’s parameters – as shown on on fig.16. 
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fig. 16 tweaking the configuration options for the purpose of virtual simulation

- When done – press Finish and then proceed with providing sample input values for WADDR2BloRAM, DIN2BloRAM, WE2BloRAM and RADDR1BloRAM signals in order to check whether a sample writing operation on the second port leads to a correct reading on the first port afterwards. For each one of the operands’ timelines right-click the corresponding row and then choose Decimal (Unsigned) from the context menu! This assists you in the process of entering the operands in decimal instead of binary or hexadecimal notation!

- Now give configure the sample values for the operands and make sure you provide them in accordance with the WE2BloRAM signal – look at fig.17 for a brief overview of the provided test bench waveform.
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fig. 17 desired set of consecutive test arguments

             - Click on the save button to confirm the changes.
- In the Sources pane now change the selection from Synthesis/Implementation to Post-Route Simulation and select only the TotalSim file without double-clicking – see fig. 18 for details.
-The window “Sources” of the  Project Navigator will now look like those on fig.18:
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fig. 18 location of the new simulation file

    - In the Processes pane start the Project navigator’s internal simulator – see fig. 19.
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fig. 19 location of the internal simulator’s trigger

             - Observe the simulation details and verify the constructed four-port RAM module validation model.
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fig. 20 produced results for verification

             - Since we have chosen FPortBloRAM to be active, this means we are now testing the scenario in which we provide some predefined address and data operands on the second port first and then expect to get a clear result on the first port. If the latter is the same as the one written on the second port, then the memory module will be working as stated. The results from the simulation confirm our expectations!

1.6. We are now going to trace the execution mechanism of one of the KCPSM3 soft-cores. Before doing this task, let us return to the normal Synthesis/Implementation mode and configure DoubleCoreValya9 as the top-level source file again. 

-Execute the step shown on fig. 21.
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fig. 21 returning to the original project hierarchy

1.7. With this step we will learn how to reprogram the second core’s so as to examine how its idle operational mode is constructed. If you remember from the beginning – when in idle state – the second KCPSM3 instantiation supports a moving LED light pattern.

All soft-cores’ programs are created as pure text files – of course with an emphasis on the assembler language in use. In the case of the KCPSM3 micrcontroller – the available instruction set is quite short and easy to handle (look at fig. 5 for a quick overview). The best teacher is practice and our first example program will be given straightforwardly as follows:

             ;Core2 program for Double_core_system

             ;

             ;

             CONSTANT waveform_port, 02             ;address of outport for light diodes indication


;

             CONSTANT pattern_10101010, AA

             ; 

      start: LOAD s3, pattern_10101010  

             ;

 drive_wave: OUTPUT s3, waveform_port

             XOR s3, FF                             ;toggle waveform

             JUMP drive_wave

The proposed code is really quite easy to understand even if you have never had any assembler language programming experience. Two 8-bit constants are declared at the beginning. The first is named waveform_port and is used to refer to the address of the output processor’s port on which LED indication is linked. The second constant is labelled pattern_10101010 and is initialized with 10101010 in binary notation. 

The LOAD instruction stores the pattern in one of the general purpose registers – s3 in the example. In contrast, the OUTPUT instruction tells the core to transfer the content of s3 to the output port of interest (in this case – waveform_port). Since there is no instruction for direct bitwise inversion, the illusion for a moving LED pattern is created via an improvised bitwise inversion realized as a XOR operation between s3 and a separate constant – FF. The looping capability is ensured by the JUMP instruction which accepts a textual label for specifying the transition in the code’s flow.

In order for us to test the code in practice – do the following:

- Open an empty notepad file and copy the text from above;

- Save the file with a specially chosen file extension - .psm (it is required by the translator which we are going to work with) – name the file procore2.psm. The name cannot contain more than 8 characters!!!

- Now, go to an already created folder for you in your computer’s root directory C:\frame. Open it and you shoud see only five files – these are the files comprising the KCPSM3’s translator program which is responsible for a proper conversion of your textual assembly program into a ROM content file suitable for inclusion into your VHDL multi-core projects.

- Copy and paste the procore2.psm assembly text file from its initial location to the frame folder.

- There is only one step needed for the actual conversion. Open now a W indows command prompt instance and navigate to the C:\frame folder (hint – the commands you need are cd and cd.. ;)). 

- When you are in the frame folder – write the following line – kcpsm3 coretest – look at fig. 22 to 25 for clarification.
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fig. 22 step 1 – invoke a Windows command prompt instance by pressing the Windows keyboard button + the letter R
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fig. 23 step 2 – navigate to the frame folder containing the translator’s files
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fig. 24 step 3 – start the translator by specifying the text of your program file – in our case – this is procore2
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fig. 25 Windows command prompt pane upon successful completion of the aforementioned steps 

- The last step is to load the newly generated vhdl programming module into the project structure, thus replacing the original one. Go to Project Navigator and from the main menu select Project=>Add Copy of Source. Then select the procore2.vhd file from the frame folder – look at fig.26 for directions.
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fig. 26 Adding the new procore2 programming file
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fig. 27 exact location of the vhdl source file
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fig. 28 choose Yes in the overwrite file dialog

- Generate the programming file for final verification. If everything is correct – we will test the second core’s program in practice. This time, programming is accomplished via Project Navigator’s iMPACT module – look at fig. 29 for orientation.
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fig. 29 starting the iMPACT programming module
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fig. 30 Press Finish and proceed with the target chip selection

- Again, you should be quite careful with the choice of target chip because the XC3S500 starter kit possesses one FPGA chip, one ROM chip and an additional Intel flash memory block. From the pop-up dialog – select DoubleCoreValya9.bit programming file and after an initial Open selection – choose Bypass for the next two windows.
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fig. 31 Press Open and then Bypass the next two windows

- Right-click the first chip on the left and choose Program... from the context menu! In this way, the FPGA chip is reconfigured as planned. We may now observe the behaviour of our „hello-world” KCPSM3 program.
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fig. 32 final programming of the FPGA chip

- Upon successful completion of all operations you should see a very fast LED pattern without any obvious signs of a moving LED light wave:
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This effect is due to the fact that we have not designed a means of slowing down the actual indication inside the KCPSM3’s controlling program. However, before modifying the soft-controller’s program file for the second time, let us test its behaviour via the built-in simulator.

- Open the project’s top-level VHDL source – DoubleCoreValya9. Uncomment lines 57 and 58 – this will enable us to observe the instruction flow during the simulation:

address2 : inout  std_logic_vector(9 downto 0); -- for simulation

instruction2 : inout  std_logic_vector(17 downto 0);-- for simulation

 Before getting on with step 1.8 – go to lines 224 and 225 and comment them:

--signal address2       : std_logic_vector(9 downto 0);

--signal instruction2   : std_logic_vector(17 downto 0);
 After this, start the design processes and regenerate the programming file again!

1.8. Create another Test Bench Waveform file – this time for examining the behaviour of the reprogrammed core. Go to Project=>New Source and then follow the directions in the diagrams which follow.
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fig. 33 creation of the new simulation file for validating the second KCPSM3’s execution flow
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fig. 34 association to the top-level VHDL module
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fig. 35 configuring the timing parameters of the simulator
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fig. 36 making resetCores active for several clock cycles – thus reinitializing the cores

- Confirm the changes by File => Save. Then, select Post-Route Simulation and activate Project Navigator’s internal simulator. Look at fig. 37 for directions.
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fig. 37 activating Project Navigator’s simulator
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fig. 38 revealing KCPSM3’s instruction and program counter’s address sequences
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- Open by means of Notepad the text log file procore2.log, which is written in the assembler frame directory C:\frame. The file is generated as a result of the translation process from the assembler translator. (The text of  procore2.log is shown above).

- Compare the instruction addresses and instruction codes of the program procore2 in the procore2.log – file with the codes of the timing diagram of procore2 execution of the simulator above.
1.9. This step requires you to modify the second core’s initial program so as to be able to notice the changing LED pattern as proven by the simulation. To do this – you should modify your first simple procore2 text file. Copy the new text as given below and save the changes into the frame folder.

            ;Core2 program for Valya_core

             ;

             CONSTANT waveform_port, 02           ;address of outport for light diodes indication


     ;

             CONSTANT pattern_10101010, AA

             ; 

      start: LOAD s3, pattern_10101010  

             ;

 drive_wave: OUTPUT s3, waveform_port

             ;


     LOAD s2, 7F

      loop2: LOAD s1, FF

      loop1: LOAD s0, FF                            ;delay size

      loop0: SUB  s0, 01                             ;delay loop

             JUMP NZ, loop0


     SUB s1, 01


     JUMP NZ, loop1


     SUB s2, 01


     JUMP NZ, loop2


     ;

             XOR s3, FF                             ;toggle waveform

             JUMP drive_wave
- Translate the modyfied assembler text in the frame by means the KCPSM3 assembler;

- Load the procore2 program code (module procore2.vhd) into the project (Project... => Add copy of source...);

- Start the design processes of the Project Navigator and download into the FPGA – chip the new programming file by means of iMPACT program;

- See the new results on the LED row of the development kit.
1.10. Finally, load the original second core’s program file by taking the source from Valya9_Core2_frame subfolder in the already known frame folder (Project..  => Add copy of source...)
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fig. 39 loading the second processor’s original program code as a copy 

1.11. Start the design processes of the Project Navigator and download into the FPGA – chip the new programming file by means of iMPACT program;
1.12. Observe the system’s behaviour.
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fig. 40 Spartan-3E starter kit overview
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